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Safety and Regulatory Information

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the system. This product 
has been designed and tested in accordance with appropriate international 
standards.

For more details on Safety and Regulatory Information, refer to “Safety and 
Regulatory Information” on page 97.

MUST READ FIRST

WARNING The WARNING notice denotes a hazard. It calls attention to a procedure, 
practice, or the like, that, if not correctly performed or adhered to, could result in 
personal injury. Do not proceed beyond a WARNING notice until the indicated 
conditions are fully understood and met.

CAUTION The CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, which, if not correctly performed or adher
to, could result in damage to the product or loss of important data. Do no
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Welcome

Thank you for choosing Agilent Technologies. In this guide, you’ll find the
setup instructions you need to begin taking indoor measurements.

Follow These Steps

If You Need Help...

Online Getting Started Guide

This guide has been installed in PDF1 format on your hard drive as a part of 
the typical installation. You can also check the following web site for the 
latest version:

http://agilent.com/find/manuals, and then search for your system type.

To Do This See This

1 Load the backpack with equipment. “Arranging Hardware in the Backpack” on 
page 13

2 Connect the equipment and turn it on. “Connecting the Hardware” on page 17

3 Put on the backpack and begin taking 
measurements.

“Suiting Up to Take Measurements” on page 36

To Do This... See This

Get training http://agilent.com/find/networks 

Check the web site for information about training registration, software 
updates, phone support, FAQs, and more.

Get help Once you start the software, press F1 to use the extensive help system.

Confirm the contents of 
your system.

Agilent System Information Guide (also available on the CD-ROM that 
came with your system). 

1. Portable Document Format - online version that can be viewed using Adobe® 

Acrobat reader. For more information, refer to http://www.adobe.com.
Agilent Wireless Solutions 5
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For more information on accessing this and other online documentation, refer 
to “Additional Documentation” on page 62.

Systems Covered By This Guide

The following table outlines the indoor wireless solutions covered by this 
guide. 

• For detailed software and hardware specifications, or lists of system 
options and accessories, refer to the Agilent System Information Guide. 

System Part Number Description

E7473A, option 180 CDMA Cellular and PCS Indoor Measurement System

E7474A, option 180 TDMA Cellular and PCS Indoor Measurement System

E7475A, option 180 GSM900, DCS1800 and GSM1900 Indoor Measurement System

E7476A, option 180 W-CDMA (UMTS) Indoor Measurement System

E7477A, option 180 CDMA 2000 Indoor Measurement System

86154A, option 030 Pen computer kit, including pen tablet, travel case, and more

86154A, option 032 Pen computer accessory kit, including pen computer auto power adapter

86154A, option 034 Pen computer accessory kit, including battery, battery charger, and more

86154A, option 036 4-port USB kit

86154A, option 425 Multi-band antenna key

86154A, option 500 Receiver battery kit

86154A, option 507 Indoor backpack, phone pouch, and more
6 Agilent Wireless Solutions
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What You’ll Find in This Chapter

To Do This See This

Load your backpack. “Arranging Hardware in the Backpack” on 
page 13 covers where in the backpack each part 
of your system belongs for maximum comfort 
and effectiveness.

Connect the antenna. “Automatic Configuration” on page 20 

Arrange cables in the backpack. “Running Cables Through the Backpack Straps” 
on page 25 

Setup the USB serial connector. “Connecting the USB Serial Converter (86154A, 
option 36)” on page 26 

Connect the hardware in the backpack. “Hardware Installation Tips” on page 18 covers 
important setup information.

“Connecting the Hardware” on page 17 shows 
how to connect hardware in several 
configurations, from single receiver and/or phone 
systems to multiple receiver and/or phone 
systems.

Put on the backpack. “Suiting Up to Take Measurements” on page 36 
covers how to wear the backpack, in addition to 
how to carry the pen tablet for hands-free 
operation.

Protect the backpack and equipment in foul 
weather.

“Using the All-Weather Cover” on page 46

Start the software. “Preparing to Take Indoor Measurements” on 
page 47
12 Agilent Wireless Solutions
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Arranging Hardware in the Backpack

You are going to carry your measurement system on your back, so Agilent has 
made certain that the backpack design arranges equipment for maximum 
measurement efficiency, while making your comfort a priority. We have 
incorporated padding and support strapping into a rugged, lightweight 
backpack, with a space for everything you need to take measurements in an 
indoor or outdoor environment. 

Since you will need to remove and replace equipment, such as batteries, the 
following illustrations remind you of the best way to arrange the equipment in 
the backpack.
Agilent Wireless Solutions 13
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Backpack with Two Receivers and Phone

Figure 1-1 Arranging receivers and phones 
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Backpack with One Receiver, No Phone

Figure 1-2 Arranging a receiver-only system

NOTE The USB serial converter is optional. The receiver can connect to the 
computer via an RS-232 null modem cable.
Agilent Wireless Solutions 15
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Phone Only

The phone pouch can accommodate up to two phones. They are laid flat, one 
in each pocket of the pouch (see Figure 1-3 on page 16). The pouch attaches 
to your belt with the velcro straps on its back. As an alternative, you can 
attach the phones directly to your belt.

Figure 1-3 Placing a phone in the phone pouch
16 Agilent Wireless Solutions



Loading, Connecting, and Using the Backpack
Connecting the Hardware

Us
in

g 
th

e
Ba

ck
pa

ck

d or 

are 
t 

indoor_gsg.book  Page 17  Tuesday, September 26, 2000  10:08 AM
Connecting the Hardware

It is recommended that you read through the “Hardware Installation Tips” on 
page 18 before you begin to connect the hardware. Then refer to Table 1-1 for 
directions to the configuration instructions for receiver, phone, and 
combination systems.

Table 1-1 Hardware Connections
. 

NOTE Your system can be configured using either Agilent Technologies-supplie
customer-supplied components.

NOTE The software must be installed before you connect the hardware. If your 
system includes the 86154A, option 030, a pen tablet computer, the softw
was factory-installed. If you are using your own computer, use the Agilen
Wireless Solutions CD and follow the instructions in “Installing the Software” 
on page 51.

If you have this system See this topic

Receiver only “Configuring a Receiver-Only System” on page 29

Phone only “Configuring a Phone-Only System” on page 31

Receiver and phone “Configuring a Receiver and Phone System” on page 33
Agilent Wireless Solutions 17
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Hardware Installation Tips

Item Information

Hardware security key The hardware security key must be connected to the PC. The 
application runs with a limited feature set without the key. You 
cannot configure projects or collect data without the key.

PC turn on After all cables are connected, turn on the PC. The PC should 
be the last device you turn on.

Configuring hardware The Agilent Wireless Solutions system assigns the serial port of 
the receiver to COM1 by default. If you want to use a different 
port, modify the serial port setting for the receiver in the 
application software as follows. 

1 After starting the Agilent E74xx application software, click the 
Configuration button. 

2 Select the Hardware tab and highlight the Agilent E645x 
receiver. Click the Modify button. 

3 Set the desired COM port. It is recommended that you accept 
the program defaults for other settings.

Cable handling Cables can be damaged. Please handle them carefully.

USB hub Draws power from the USB port and does not require external 
power (which can damage the unit).

Dual Socket I/O card As an alternative to the USB serial converter, you can use a dual 
Socket I/O card to connect up to two phones or receivers to the 
pen tablet.

Troubleshooting See “Solving Problems and Updating Your System” on page 81 
for troubleshooting information.
18 Agilent Wireless Solutions
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CAUTION • For optimum performance, it is recommended no more than -40 dBm be 
applied to the input of all other types of receivers.

• The Agilent E74xx receivers do not protect against the ingress of water. 
The receiver protects against entry of solid foreign objects greater than, or 
equal to, one millimeter.
Agilent Wireless Solutions 19
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Automatic Configuration

The Agilent Wireless Solutions Software can automatically configure 
hardware that has been connected to your laptop. By clicking the Auto Config 
button, you begin the automatic configuration wizard (see Figure 1-4 on 
page 21). This wizard checks a defined list of COM ports for recognized 
hardware. Once all ports have been checked, the attached hardware is 
automatically set up with the correct settings.

The automatic configuration wizard can be used for setting up new hardware 
and projects, or for updating previously saved configurations.

You can speed up the configuration process by selecting the types of hardware 
to be attached to your system and the COM ports used. This limits the list of 
hardware types and COM ports searched during configuration. To enable this 
feature select Tools > Options > Other >”Enable auto-config COM and device customization”. 
See Figure 1-5 on page 21, and Figure 1-6 on page 22.

NOTE If your receiver has internal GPS and you configure a project with automatic 
configuration, the project is configured with the internal GPS. To run the 
indoor application, you must replace internal GPS in the Hardware 
Configuration with a computer pen. See Making an Indoor Measurement in the 
online help for information.
20 Agilent Wireless Solutions
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Figure 1-4 Accessing the Automatic Configuration Wizard

Figure 1-5 Enabling the auto-configuration customization features

Automatic
Configuration
button
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Figure 1-6 Defining COM ports and device types to be searched during the 
configuration process
22 Agilent Wireless Solutions



Loading, Connecting, and Using the Backpack
Connecting the Antenna (86154A, option 425)

Us
in

g 
th

e
Ba

ck
pa

ck

indoor_gsg.book  Page 23  Tuesday, September 26, 2000  10:08 AM
Connecting the Antenna (86154A, option 425)

Your indoor measurement system includes three antenna stubs, labeled with 
green, orange, and yellow dots as follows.

GREEN dot: 824 - 894 Cellular band

1850 - 1990 PCS and 1900 GSM bands

832 - 925 JCDMA band

ORANGE dot: 880 - 960 GSM 900 band

1710 - 1880 DCS and Korean CDMA bands

YELLOW dot: 1920 - 2170 3GPP band

To Connect an Antenna

1. Remove the antenna cable from the ground plane (see Figure 1-7 on 
page 24), if it is attached..

2. If the antenna was not ordered with the backpack and/or the antenna cable 
connector is not connected to the ground plane:

❍ Place the O-ring beneath the flange-end connector and hold it on one 
side of the ground plate.

❍ Place the lock washer, then the nut, then the non-flange end connector 
and hold it on the opposite side of the ground plate.

❍ Screw the two together.

3. Remove the protective foam and the fabric antenna pocket from the 
top-inside corner of the backpack, and open the flaps of the fabric 
antenna enclosure.

4. Remove the fabric antenna enclosure from the top-inside of the backpack, 
and open the flaps of the fabric antenna enclosure.

5. Slide the ground plate into the fabric enclosure, with the longer end of the 
bulkhead connector facing outward, and refasten the velcro.
Agilent Wireless Solutions 23
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6. Screw on the antenna stub that is appropriate for your measurements, and 
place the antenna assembly in the top-right, or top-left corner of the 
backpack.

7. Insert the foam with the opening toward the back.

8. Attach the antenna cable.

9. Reattach the battery compartment flap to the side of the pack (if it has 
become detached), and then slide the entire antenna assembly into the 
backpack compartment.

10. Attach the antenna cable to the receiver.

Figure 1-7 Antennas in place in the top portion of the backpack

Repeat the procedure for the second antenna assembly.
24 Agilent Wireless Solutions



Loading, Connecting, and Using the Backpack
Running Cables Through the Backpack Straps

Us
in

g 
th

e
Ba

ck
pa

ck

indoor_gsg.book  Page 25  Tuesday, September 26, 2000  10:08 AM
Running Cables Through the Backpack Straps

To minimize the display of cables and the potential for snagging them, they 
are threaded through the shoulder straps in the backpack, as shown below.

Figure 1-8 Running cables through the backpack straps
Agilent Wireless Solutions 25
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Connecting the USB Serial Converter (86154A, 
option 36)

The USB-to-Serial Converter, EdgePort/4, from Inside Out Networks™ is
true Plug-and-Play compatible device. It reduces the number of cables ex
the backpack by multiplexing up to four serial ports onto one USB cable. 
use the device, you connect the serial devices to the converter, then conn
the converter to the computer.

NOTE Windows 98 and Windows NT provide USB and Plug-and-Play capability.
These instructions apply to Windows 98 and Windows NT only.

To Connect the USB Serial Converter for Backpack Usage

For Indoor systems, Agilent Technologies pre-installs the software drivers
You do not need to install or configure software to use the USB serial 
converter.

1. Unzip the left shoulder strap pocket.

2. Feed the USB connector up through the strap, out through the top, th
down through the hole in the top of the backpack (see Figure 1-8 on 
page 25).

3. Pull the cable into the inside of the backpack, and plug it into the USB
serial converter.

4. Fasten the USB hub into the case (see Figure 1-1 on page 14).

5. Switch on the power to the pen tablet and start the software.
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Windows makes the following COM port assignments:

WARNING Do not connect power to the EdgePort/4 USB. It does not require external power, 
even though there is a power connector on the back. Any power source that is of 
an incorrect voltage, such as the receiver battery, will permanently damage the 
EdgePort/4.

CAUTIONS • The USB connector attaches to the pen tablet on the outside of the case. 
As you collect data, be careful not to bump the USB connector against 
your surroundings. Dropping or bumping the system may cause the 
measurement system to fail.

• USB connectors other than Inside Out Network’s EdgePort/4 are not 
guaranteed to work with the Agilent system and may, in fact, cause 
problems with the software.

NOTES • The USB serial converter has an optional +5V input which is NOT 
required for use. The USB connection provides sufficient power to the 
converter to support four serial devices.

• If you ordered 86154A, option 36, the 4-port USB serial converter, but did 
NOT order your pen tablet from Agilent Technologies, you need to first 
install the device drivers from the floppy disk that came with the option, 
using the floppy drive.

Converter Port Windows

1 COM5

2 COM6

3 COM7

4 COM8
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To Connect the USB Serial Converter for Use with a Laptop or a 
Non-Agilent-Provided Pen Tablet

This procedure is for customers wishing to use the device on laptop systems in 
a drive test environment, or indoor customers installing on their own 
computing device.

1. Plug in the EdgePort/4 to the USB port. The device is recognized by 
Windows 98 or Windows NT as new hardware.

2. Insert the Inside Out Network’s EdgePort/4 driver diskette in the device’s 
floppy drive.

(For the Fujitsu Stylistic 2300 pen tablet computer, the floppy drive is 
connected via a connector exposed by removing the battery. This mu
done with external power connected.)

3. Follow the directions in the New Hardware wizard to select the floppy
drive as the source for the drivers.

The drivers load and are configured automatically. The converter is now re
to use.
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Configuring a Receiver-Only System

NOTE It is recommended that you configure the measurement project before you 
load equipment into the backpack.

1. Connect the hardware security key to the pen tablet PC, and slide the pen 
tablet into the pen tablet case.

2. If you are using a USB serial converter, thread the USB serial converter 
cable through the left shoulder strap of the backpack. See “Connecting the 
USB Serial Converter (86154A, option 36)” on page 26 for more 
information.

If you are connecting directly via COM1, thread the RS-232 null mode
cable through the right shoulder strap of the backpack.

3. Load the hardware into the backpack as shown in “Backpack with One 
Receiver, No Phone” on page 15.

NOTES • Be sure to secure the receiver in place using the strapping system.

• When you are using two receivers, be sure to load them with the RF 
connectors toward the middle of the pack for best connections. Place one 
receiver facing forward, the other facing backward.

4. Set the battery cable switch to the OFF position and connect the battery 
cable to the receiver.

NOTE The battery must be fully charged and ready for prolonged testing.
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5. Connect the RF antenna cable to the RF input of the receiver. (See Figure 
1-10 on page 34 for a cabling illustration.)

6. If you are using a USB serial converter, secure it in place, connect the 
Agilent digital receiver using the RS-232 null modem cable, and connect 
the USB cable to the hub. (Or, if you are connecting directly to COM1, 
connect the Agilent digital receiver to the RS-232 null modem cable.)

7. Switch on the battery(ies), and close up the backpack.

8. Put on the backpack (see “Suiting Up to Take Measurements” on page 3 
for details), pick up the pen tablet in the case, and connect the USB 4
converter cable to the USB port of the pen tablet PC (or connect the R
232 null modem cable to the pen tablet serial port).

9. Turn on the pen tablet’s power and start the Agilent Technologies 
application software. Find instructions for using the software in the onl
help by pressing F1.
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Configuring a Phone-Only System 

Figure 1-9 Connecting a phone to the pen tablet
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NOTES • It is recommended that you configure the measurement project before you 
load equipment into the backpack.

• If you are using multiple phones, you need to insert a dual Socket I/O card 
to which you can attach two phones. The card is inserted in the pen 
tablet’s PCMCIA slot.

1. Connect the hardware security key to the parallel port of the pen tabl
PC, and slide the pen tablet into the pen tablet case.

2. Connect the phone cable(s) to the phone(s) and place them in the ph
pouch (if you are using one), as shown in “Connecting a phone to the pen
tablet” on page 31, or connect the phones to your belt.

3. Connect the phone cable(s) to the pen tablet, pick up the pen tablet, 
turn on all power.

4. Start the Agilent Technologies application software. Find instructions 
running the software in the online help by pressing F1.
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Configuring a Receiver and Phone System

NOTE It is recommended that you configure the measurement project before you 
load equipment into the backpack.

1. Connect the hardware security key to the parallel port of the pen tablet 
PC, and slide the pen tablet into the pen tablet case.

2. If you are using a USB serial converter, thread the USB serial converter 
cable through the left shoulder strap of the backpack. See “Connecting the 
USB Serial Converter (86154A, option 36)” on page 26 for more 
information.

If you are connecting directly via COM1, thread the RS-232 null mode
cable through the right shoulder strap of the backpack.

3. Load the hardware into the backpack as shown in “Backpack with Two 
Receivers and Phone” on page 14. 

NOTES • Be sure to secure the receiver in place using the strapping system.

• When you are using two receivers, be sure to load them with the RF 
connectors toward the middle of the pack for best connections. Place one 
receiver facing forward, the other facing backward.

4. Set the battery cable switch to the OFF position and connect the battery 
cable to the receiver.
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NOTE The battery should be fully charged and ready for prolonged testing.

5. Connect the RF antenna cable to the RF input of the Agilent digital 
receiver. (See Figure 1-10 for a cabling illustration.)

Figure 1-10 Connecting receivers and phones via the USB serial converter

6. If you are using a USB serial converter, secure it in place, connect the 
Agilent digital receiver using the RS-232 null modem cable, and connect 
the USB cable to the hub. (Or, if you are connecting directly to COM1, 
connect the Agilent digital receiver to the RS-232 null modem cable.)
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7. Connect the phone cable(s) to the phone(s) and place them in the phone 
pouch, as shown in “Arranging receivers and phones” on page 14.

8. Connect the phone pouch to your belt or to the backpack waist belt.

9. Switch on the battery(ies), and close up the backpack.

10. Put on the backpack (see “Suiting Up to Take Measurements” on page 3 
for details), pick up the pen tablet in the case, and connect the USB 4
converter cable to the USB port of the pen tablet PC (or connect the R
232 null modem cable to the pen tablet serial port).

11. Turn on the power to the pen tablet and start the Agilent Technologie
application software. Find instructions for running the software in the 
online help by pressing F1.
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Suiting Up to Take Measurements

There are three main configurations which you will use for taking indoor 
measurements: 

• Backpack, phone pouch, and pen tablet
• Backpack and pen tablet
• Phone(s) and pen tablet using the harness

Each one is pictured and described in this section.

Figure 1-11 Using the pen tablet
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NOTE Adjust the backpack properly so that it is comfortable to wear. If at any time 
you suffer from any discomfort, stop testing and adjust the backpack and other 
equipment.

Adjust the Straps

The backpack and the harness use a system of ladderlocks to make adjusting 
the straps easy. 

To tighten the straps, pull the strap closest to the tab of the ladderlock. To 
loosen the straps, pull the strap closest to the tab upward. (See Figure 1-12 on 
page 38.)
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Figure 1-12 Tightening and loosening the straps

Put On the Backpack

With a loaded backpack, it is recommended that you connect the straps in the 
following order (refer to Figure 1-12 on page 38 for information on tightening 
and loosening straps):

1. Loosen all straps and place the pack on your back.

2. Fasten the waist belt and tighten it so that it rests on your hips. The waist 
belt should always remain on your hips, even after the harness is adjusted.
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3. Tighten the shoulder straps until the pack feels comfortable (see Figure 1-
13 on page 39). The backpack’s weight should be carried on your hips 
maximum comfort. The shoulder straps help stabilize the pack on you
body.

Figure 1-13 Tightening the shoulder straps on the backpack

4. Connect and tighten the sternum strap (see Figure 1-14 on page 40). You 
can change the vertical position so that the strap fits comfortably acro
your chest. The sternum strap reduces shoulder fatigue and increase
mobility by pulling the shoulder straps inward.
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Figure 1-14 Tightening the sternum strap

NOTE Once the backpack is loaded with equipment and you have put it on, check the 
cable lengths. If they need adjusting, remove the backpack, adjust the lengths, 
and put the backpack on again.

Hands-free Pen Tablet, Backpack, and Phone Pouch

The hands-free platform attaches directly to the pen tablet case.

To Attach the Pen Tablet to the Hands-free Platform

1. Lay the pen tablet in its case face down on a table or counter.

2. Press the hands-free platform onto the pen tablet case placing it so that the 
velcro tabs align. (Refer to Figure 1-15 on page 41.)
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3. Fasten the tabs down.

Figure 1-15 Attaching the pen tablet to the hands-free platform

4. Turn the pen tablet over and check that the strap lengths are 
approximately the same. Spread the straps to the sides.

5. Put on the backpack (see “Put On the Backpack” on page 38).
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6. Attach the platform to the D-rings on the harness, selecting the set that 
best accommodates your height. Make sure the connectors snap 
completely into place (see Figure 1-16 on page 42).

Figure 1-16 Attaching the pen tablet straps to the backpack harness

7. Attach the phone pouch to the backpack waist belt as shown in Figure 1-
17 on page 43, or loop the pouch straps over your own belt.
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Figure 1-17 Attaching the phone pouch to the backpack

To remove the backpack and pen tablet, disconnect the connectors from the 
backpack to remove the pen tablet, then remove the backpack.
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Hands-free Pen Tablet and Phone Pouch

You can use the pen tablet without the backpack by connecting it to the 
harness. The phone pouch attaches directly to your belt, or you can attach the 
phones to your belt directly.

To Attach the Pen Tablet to the Hands-free Platform

Refer to Figure 1-15 on page 41.

1. Lay the pen tablet in its case face down on a table or counter.

2. Press the hands-free platform onto the pen tablet case placing it so that the 
velcro tabs align.

3. Fasten the tabs down.

4. Turn the pen tablet over and check that the strap lengths are 
approximately the same.

To Put on the Harness and Attach It to the Pen Tablet

1. Put the harness straps over your shoulders, positioned so that the Agilent 
label on the webbing falls approximately between your shoulder blades.

2. Sit in a chair, place the pen tablet in your lap, and connect the back of it to 
the harness at the waist. 

3. Tighten the waist straps by pulling the strap toward the rear (refer to 
Figure 1-12 on page 38). This helps to keep the harness positioned 
correctly on your torso.

4. Attach the platform connectors to the D-rings on the harness, selecting the 
set that best accommodates your height. Make sure the connectors snap 
completely into place. See Figure 1-16 on page 42.

5. Stand and adjust the length of the pen tablet platform straps to the proper 
length. (Refer to Figure 1-12 on page 38 for information on tightening 
and loosening straps)
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6. Loop the phone pouch straps over your belt, or attach the phone(s) 
directly to your belt.

To remove the harness, sit down and disconnect all four connectors.

Pen Tablet Tilted for Safety

WARNING Whenever you navigate stairs, escalators, or elevators, be sure to tilt the pen 
tablet for visibility (see Figure 1-18 on page 45). You can tilt it and hold it in place 
with only one hand.

Figure 1-18 Tilt the pen tablet for safety on stairways. 
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Using the All-Weather Cover

The all-weather cover protects the backpack and its contents from dust, sand, 
rain, snow, or hot sun. 

To Use the Cover 

1. Take the cover out of the bottom velcro storage compartment.

2. Drape it over the front and top of the pack. The elastic should enable the 
cover to snugly surround the whole backpack with no gaps.

3. Fasten the leash behind the shoulder straps to secure the cover in place.

Figure 1-19 All-weather cover
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Preparing to Take Indoor Measurements

Once all equipment has been configured, and the backpack has been loaded 
correctly, you are ready to make measurements. The indoor test system relies 
on the user inputting positional information. This is done by setting waypoints 
where measurements are to be taken against an imported map file.

The user moves from one waypoint to the next and, as each waypoint is 
highlighted, measurements are interpolated from the last checked point.

There is no need for a GPS or other positional information. Positions relative 
to external GPS coordinates can be defined during the setup procedure.

To Start the Software

NOTE As an alternative to using the pen for input/selections, you can display a pen-
activated keyboard (including all standard keys and function keys) on the 
screen. To do that, choose Start > Programs > PenX 1.51 > Onscreen Keyboard.

Do This See This

1 Choose the Start menu and click Programs

2 Click Agilent E74xx (the name of your 
Agilent Wireless Solutions)

A sub-menu should appear, listing the 
components of the Wireless software.

3 Click Agilent E74xx Series to start the 
software.

The copyright screen appears for a few seconds, 
then the software appears on your screen, ready 
to use.

Note: The first time you start the software you 
have the opportunity to run the online tutorial, a 
tool that is designed to help you get the most 
from the software.
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Configuring a Project

The E74xx software provides an Auto Configure feature that sets up 
measurement projects for you. Each project consists of measurements and the 
hardware you have connected. The online help provides instructions for all 
procedures.

NOTE If you are using a receiver with internal GPS and you use Auto Configure, the 
software will find the GPS unit. To perform indoor measurements, you need 
to delete the GPS resource and replace it with a computer pen. Check the 
online help for instructions.
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Setting Up GPS

The backpack has been designed to accommodate a GPS receiver and 
antenna, as an alternative configuration. The GPS antenna fits snugly in the 
pocket in the top flap of the backpack, and the antenna cable fits through the 
opening in the top of the backpack.

NOTE The E74xx software works with either a GPS receiver or a computer pen, not 
both at the same time. It is recommended that you configure separate projects 
for each use. Refer to the online help for details.

To Set Up the Backpack for Use with GPS

1. Position equipment as you see in Figure 1-1 on page 14, with a single 
Agilent receiver.

2. Fasten the GPS receiver into the second receiver position, using the 
system of straps.

3. Place the GPS antenna in the pocket in the top flap of the backpack, as 
shown in Figure 1-20 on page 50.

4. Thread the GPS antenna cable down through the hole in the top of the 
backpack and connect it to the GPS receiver.

5. Connect the RS-232 cable to the GPS receiver, then connect the other end 
to the Agilent receiver.
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Figure 1-20 Inserting a GPS antenna
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What You’ll Find in This Chapter

Agilent-Purchased Pen Tablet Users Read This First

If you purchased your pen tablet computer from Agilent Technologies, it is 
equipped with a LAN card to enable you to connect to your company’s loc
area network. In addition, the software came factory-installed. To install ot
software on your pen tablet computer, including system updates, you mu
first configure network parameters for your network in order to connect to
your company LAN. Contact your system administrator for the required 
parameters.

The pre-installed software includes:

• Agilent Wireless Solutions software
• USB serial converter software for Inside Out Network’s Edgeport 4 
• 3COM® 10/100® Megahertz LAN card software
• Dual Socket I/O™ card software
• Documentation in PDF format, located in the 

c:\Program Files\Agilent Technologies\E74xx\documents subdirectory
• Adobe Acrobat Reader (for viewing and printing PDF files)

To Do This See This

Install the system software. “Installing the Software” on page 53

Install the License Manager Software. “Agilent License Manager” on page 56

Install Adobe Reader. “Installing Adobe Reader” on page 59

Install other drivers, including LAN, socket I/O, 
and others.

“Installing Other Drivers” on page 61

Check requirements for the computer. “Installing Other Drivers” on page 61
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Installing the Software

If your software has not been pre-installed, before you begin installing the 
software, your computer system must be configured with the minimum 
requirements. Check “Computer Requirements” on page 65.

Follow These Steps

Do This See This

1 Connect the pen tablet to your LAN via the 
LAN card that was factory-installed. (If you did 
not purchase your pen tablet PC from Agilent, 
you may need to use another means to install 
the software, such as a CD-ROM.)

Confer with your system administrator for 
information and assistance on connecting your 
pen tablet PC to your company’s LAN.

2 Once connected to the LAN, insert the CD-
ROM that came with your system into a host 
computer that is accessible via the LAN.

When the Welcome screen appears on the host 
computer, choose Cancel, since you are not 
installing on the computer containing the CD, but 
onto the pen tablet.

3 Using the Windows Explorer, over the LAN 
locate the computer that contains the Indoor 
Wireless Solutions CD-ROM, and double-click 
setup.exe.

A Welcome dialog box appears instructing you to 
close any currently running Windows 
applications before you begin installation.

4 Click Next when you are ready to continue the 
installation. Type your name and the name of 
the company you work for, then click Next.

The “Choose Destination Location” dialog box 
appears. The default folder for installation is 
C:\Program Files\Agilent Technologies\E74xx 
(depending on the system you’re installing). 

5 If you wish to install the program in a folder 
other than the default, click Browse to display 
text. When the correct destination folder 
appears in the field, click Next. 

The Setup Type box appears.

6 Select which language you would like to see 
the online help and tutorial displayed in, click 
Next.

For more information see “Online Help and 
Tutorial Language Options” on page 55
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NOTE It is recommended that new users go through the online tutorial before using 
the software. When you start the software for the first time, you will have the 
option of viewing the tutorial before working in the software.

7 Select the type of installation you want: 
typical, compact, or custom, and click Next. 

•Typical: Includes Agilent E74xx application, 
online help files, PDF files of this and other 
guides, and tutorial.

•Compact: Includes Agilent E74xx application 
and online help files

•Custom: Lets you select individual 
components. 

The Destination Folder box appears.

Agilent Technologies recommends using the 
Typical installation. Verify you have enough disk 
space available to perform the Typical installation 
before proceeding.

8 Select the destination folder for the program. 
The default folder is “Agilent E74xx” or you 
can select a different folder that can be found 
on your system. Click Next.

The list of folders found on your system is 
displayed.

Agilent Technologies recommends using the 
default folder “Agilent E74xx”.

9 Verify that Setup Type, Target Folder, and 
User Information are correct, and click Next.

The software installs from CD to PC.

10Click Finish to complete the installation. Depending on the files installed or updated, you 
may be prompted to reboot your system.

Do This See This
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Online Help and Tutorial Language Options

During the software installation, you can select the language for the online 
help and tutorial (English is always the most up-to-date). The measurement 
software does not change. The currently supported languages are:

To change the language, once the installation is complete, you must re-install 
the software.

• Simplified Chinese • Korean

• English (default) • Brazilian Portuguese

• Japanese • Latin American Spanish
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Agilent License Manager

The hardware key that came with your Agilent Technologies system enables 
and secures the functionality you purchased from Agilent Technologies. In 
addition to the parallel port hardware key, the License Manager also supports 
the Sentinal SuperPro USB port hardware key. The Agilent License Manager, 
automatically installed when you install the Agilent E74xx software, enables 
you to manage licensing security information. You can use the software to:

• Add product options to license keys. You can add licenses (temporary or 
permanent) to the license key by entering a string obtained from an 
Agilent representative.

• Transfer licensed product options between license keys in order to 
consolidate licenses onto one key.

• Transfer a license from one key to another.
• Transfer licenses between keys on different computers. You can move 

license options to license keys on another computer that is located 
anywhere from the same room to another country.

Starting the License Manager

Make sure to plug your hardware key into the parallel or USB port (depending 
on the key you’re using) before you begin this process.

Do This See This

1 Choose the Start menu and click 
Programs.

2 Click Agilent E74xx (the name of your 
Agilent Wireless Solutions)

A sub-menu should appear, listing the components of 
the Wireless software.

3 Click License Manager to start the 
software.

The License Manager begins showing the enabled 
software options.
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Learning the License Manager

For further information about the Agilent Technologies License Manager, 
refer to the following resources:

Transferring Licenses

Your software license key contains the code necessary to enable your 
measurement and control features. 

Using the License Manager software, you can transfer license options 
between software license keys. To limit the number of software license keys 
you have attached to your PC, you can consolidate the license codes onto one 
key. Figure 2-1 n page 58 shows the principle of software license 
management.

Resource Description

Online Help Available from the License Manager Help menu or by pressing 
F1, covers all functionality. It is the program’s reference and 
includes step-by-step instructions for basic operations.

Support Available from the Help menu, directs you to the support 
provided by Agilent Technologies.
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Figure 2-1 Example showing license key transfer process

License Option 100 License Option 150

Connect All keys to PC and
use the License Manager to transfer key codes

License Option 100 with 150 Blank key

1

2

3

Note: The license options function if they are left on the individual keys.
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Adobe Acrobat Reader

This getting started guide, along with the Agilent Technologies System 
Information Guide and the Agilent Technologies Wireless Solutions Getting 
Started Guide, have been pre-installed in the \documents directory on your hard 
drive, if:

• You purchased your pen tablet from Agilent.

• You installed the software using the typical install. 

The documents are also included on your system CD-ROM in the \documents 
directory in PDF format. To view or print PDF documents, Adobe Reader 
must be installed. 

NOTES • If you purchased your pen tablet from Agilent, the Adobe Reader was 
installed along with the software. Or, if you installed the software on your 
own computer using the typical install, the Adobe Reader was installed.

• If your pen tablet was not purchased from Agilent, it may not include a 
LAN card. You can access the CD-ROM via a CD-ROM drive. If neither 
option is available to you, contact Agilent Technologies for assistance.

• Upgrades to the Adobe Reader can be found on the Adobe web site,
http://www.adobe.com

Installing Adobe Reader

NOTE Before starting the installation process, ensure that you have removed 
previous versions of Adobe reader. This version is Adobe Reader 4.05.
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Do This See This

1 Insert the CD-ROM into the CD-ROM 
drive, choose Start>Run, and type 
d:\Acrobat\rs405eng.exe where d: is the 
drive containing the software CD-ROM. 
Click OK.

A Welcome dialog box appears detailing copyright 
information.

2 Click Next when you are ready to 
continue the installation.

The “Choose Destination Location” dialog box 
appears. The default folder for installation is 
C:\Program Files\Adobe\Acrobat4.0

3 If you wish to install the program in a 
folder other than the default, click 
Browse to display text. When the correct 
destination folder appears in the field, 
click Next. 

The software will install from CD to PC. 

4 Once the installation has completed. 
Click OK. 

PDF User Guide for the Adobe Reader has been 
provided on the CD.
60 Agilent Wireless Solutions



Installing the Software
Installing Other Drivers

In
de

x
In

st
al

l t
he

So
ftw

ar
e

r 
door 
fer to 

indoor_gsg.book  Page 61  Tuesday, September 26, 2000  10:08 AM
Installing Other Drivers

Pen tablets purchased from Agilent Technologies (86154A, option 30) have 
all required software pre-installed, including:

• Serial I/O software driver. Agilent includes the Socket Ruggedized Dual 
Serial I/O card™. See Chapter 3, “Software Setup” of the Serial I/O ™ 
and Ruggedized Serial I/O Card ™ User’s Guide for instructions on 
installing the software for that specific card.

• USB serial converter software driver (if you are using a USB serial 
converter) Agilent includes Inside Out Network’s Edgeport 4.

• LAN card software driver. Agilent includes the 3COM® 10/100® 
Megahertz LAN card.

If you are supplying your own pen tablet, you must install a software drive
for any devices that you are using. These are separate from the Agilent in
measurement system software and are included with the device itself. Re
the installation instructions that come with the device.
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Additional Documentation

Additional documents are supplied with your system. These include:

• Agilent Technologies Wireless Solutions Getting Started Guide: a guide 
that describes how to setup the elements of the drive test solution, 
including configuring GPS units, verifying the system, and starting the 
system (PDF format).

• Agilent Technologies Indoor Test System Setup Guide: (this guide) a 
guide that describes how to setup the elements of the indoor solution, 
including the backpack, the hands-free platform, and the receiver batteries 
(PDF format).

• Agilent Technologies System Information Guide: a guide containing 
software and hardware specifications, system options and accessories, 
including part numbers.

• Various background technical-papers and application notes. 
Note: These documents were valid at time of shipping. However, since 
that time there may have been some updates or additional documents 
created. To ensure that you have the lastest information, please look at the 
Agilent web site.

These documents can be viewed online or printed.

Location of Online Documents

The documents were installed with your software application, if you used the 
typical installation option. The documents were installed in the following 
location:

C:\Program Files\Agilent Technologies\E74xx\Documents
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If you chose not to install the documents during software installation, you can 
copy them from the CD. The documents can be found in the following 
location on the CD:

D:\documents\

(d: represents the drive letter of your CD-ROM reader.)

Viewing and Printing Online Documents

Before you can view and print these documents, you must have the Adobe 
Reader installed on your system. For more information about PDF files and 
the Adobe Reader, refer to the Adobe Web site (http://www.adobe.com).

The Adobe Reader is supplied on your CD and is installed as part of the 
typical installation. Refer to “Installing Adobe Reader” on page 59 for more 
information.

NOTE The latest version of the Adobe Reader can also be downloaded from the
Adobe Web site (http://www.adobe.com).

To View a PDF Document Installed with Your System

Do This Additional Information

1 From the program task bar, select Start > 
Programs > Adobe > Adobe Reader.

The Reader software is displayed.

2 From the File menu of the Reader, select Open. A dialog box appears listing the available 
drives you can read.
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To print a PDF document or sections from it

3 Select the C: drive and then select the documents 
folder.
C:\Program Files\Agilent Technologies\E74xx\Documents

The dialog box displays the PDFs contained 
on your CD.

4 Choose the document you wish to view. • Getting Started Guide.PDF - a PDF file 
of this Guide.

• Support Information.PDF - a guide 
containing system and accessory options 
and part numbers.

• Indoor Getting Started Guide.PDF - a 
guide that helps you set up your system 
for indoor measurements (Option 180).

5 Search for the information you require. This can be done using:

• Hypertext links (blue text)

• The Adobe Reader search tool, found on 
the Tools menu.

Do This Additional Information

Do This See This

1 With the document opened, search for the 
information you require to be printed.

2 Note the page number(s) displayed at the 
bottom of the Reader.

Note: The page numbers shown in the document 
may not correspond to the page numbers 
displayed by the reader.

3 Select File > Print and configure the print 
options for your printer.

CAUTION: when printing sections from the 
Getting Started Guide, ensure that a page or 
page range is specified. The Getting Started 
Guide is approximately 100 pages.
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Computer Requirements

Personal Computer Recommendations, Minimum

The PC requirements differ depending on the operating system, and on 
whether you wish to collect data from a single phone or multiple phones.

Single phone

Single phone

• Windows 95/98
❍ Minimum: 233 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 266 MHz Pentium II or III, 64 Mbytes RAM

• Windows NT/2000
❍ Minimum: 233 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 266 MHz Pentium II or III, 96 Mbytes RAM

Multiple phone

• Windows 95/98
❍ Minimum: 233 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 366 MHz Pentium II or III, 64 Mbytes RAM

• Windows NT/2000
❍ Minimum: 266 MHz Pentium, 64 Mbytes RAM
❍ Recommended: 366 MHz Pentium II or III, 96 Mbytes RAM

Common Requirements

• RS-232 DB9 Serial Port
• Parallel port: 25-pin bi-directional
• 90 Mbytes disk space for software installation
• 200 Mbytes disk space for data (recommended)
• CD-ROM drive recommended
• 800 x 600 display resolution minimum
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What You’ll Find in This Chapter

To Do This See This

Learn about backpack features “Backpack Features” on page 69

Learn about phone pack features “Phone Pouch Features” on page 71

Learn about the pen tablet case “Pen Tablet Case Features” on page 72
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Backpack Features

Figure 3-1 Backpack features
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Figure 3-2 View of the backpack top
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Phone Pouch Features

Figure 3-3 Phone pouch features
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Pen Tablet Case Features

Figure 3-4 Pen tablet case features
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What You’ll Find in This Chapter

To Do This See This

Operate the battery “Battery Operation (86154A, option 500)” on 
page 75

Charge the battery “Battery Charging” on page 75

Troubleshoot the battery “Troubleshooting” on page 77

Understand the battery characteristics “Battery Characteristics” on page 78

Dispose of the battery “Battery Disposal” on page 79

Use the power cable “Power Cable” on page 79
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Battery Operation (86154A, option 500)

Follow these battery operation tips for best results:

• To enable the battery to operate the receiver, place the battery pack in the 
backpack, plug it into the receiver, and turn it on. 

• To turn on the battery, locate the on/off switch and switch it to ON
(0 = off; 1 = on). 

• The led, when lighted, indicates that the power is turned on.
• When not in use, the battery should be turned off to save the charge. 

WARNING The charger must not be connected to the battery pack when the battery pack is 
attached to the receiver. There are no serviceable parts inside. Do not 
disassemble.

Battery Charging

A fully-charged battery powers the receiver for four to four and one-half 
hours.

CAUTION Do not use any charger other than the Agilent 86154-60019. (The charger is 
marked with the part number.)

1. Remove the battery pack from the backpack.

2. Plug the battery pack into the charger.

3. Connect the AC line cord to the charger and to the AC line.

4. Turn the battery switch to the ON position.
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When the battery pack begins its charging cycle, the status LED flashes 
yellow, then switches to solid yellow during the charge. When the battery 
pack is fully charged, the status LED turns green. No LED indicates that there 
is no battery installed, or that the battery is over voltage.

WARNING This is a Safety Class 1 product when the battery is being charged and is 
provided with a protective earthing ground incorporated in the power cord. The 
mains plug shall only be inserted in a socket outlet provided with a protective 
earth contact. Any interruption of the protective conductor inside or outside of 
the product is likely to make the product dangerous. Intentional interruption is 
prohibited.

NOTE Continuing to charge the battery pack after the green status LED lights does 
not damage the unit. It continues to charge in the trickle charge mode.

It takes four hours for an initial charge or to charge a fully depleted battery at 
room temperature. Charging the battery at elevated temperatures increases the 
charge time. 
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Troubleshooting

If the battery pack does not work, follow these steps to determine the cause 
and resolve the problem:

1. Make sure the receiver works with the DC power supply. 

2. If the receiver operates on DC power from the power supply, check all of 
your connections. Is the battery connector firmly in place? Is the power 
switch set to ON? The green LED on the receiver should be continuously 
on if there is a DC power supply.

3. Make sure that the battery pack is taking a charge from the charger. 
Follow the recharging procedure. Usually batteries near the end of their 
life will still take a partial charge. If there is no charge at all, you may 
need to replace the charger or the battery pack: 

❍ Receiver battery kit, part number 86154-60005

▲ Receiver battery 86154-60051
▲ Receiver battery charger 86154-60019
▲ Receiver battery power cord for non-US option (localization 

same as option 030)
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Battery Characteristics

NOTE All characteristics are at 25° and at the beginning of the battery life.

Characteristic Description

Output voltage 14.4 volts

Capacity 45 watt hours

Service life 500 cycles to 80% initial capacity (at 25°)

Chemistry Nickel metal hydride

Operating time 4.5 hours

Charge time 4 hours

Charging temperature 0° to 40° C

Discharging temperature -10° to 45° C

Storage temperature -20° to 45° C

Maximum relative humidity 35% to 85% RH non-condensing

Physical Characteristics

Weight 1.9 lb. (0.86 Kg)

Height 139 mm

Width 88 mm

Depth 40 mm

Charger Supply Requirements

Nominal input voltage 100/115/230/240 VAC

Input voltage range 85-265 VAC

Nominal input frequency 50-60 Hz

Input frequency range 47-63 Hz

Output power 30 watts maximum

Charge Rate 1.3 A

Environmental Conditions

Portable Altitude Up to 4,572 meters (15,000 feet)
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Battery Disposal

When the battery is exhausted and/or ready for disposal, dispose of it 
according to your country’s requirements. Within the US, you may contact 
Rechargeable Battery Recycling Corporation (RBRC) for disposal.

The RBRC seal on the nickel metal hydride battery pack indicates that Agilent 
Technologies is voluntarily participating in an industry program to collect and 
recycle these battery packs at the end of their useful life, when taken out of 
service within the United States. The RBRC program provides a convenient 
alternative to placing spent nickel metal hydride battery packs into the trash or 
municipal waste stream, which is illegal in some areas.

For information on recycling the battery outside the US, please check with 
your local Agilent sales office.

Power Cable

The battery pack charger is equipped with a three-wire power cable, in 
accordance with international safety standards. When connected to an 
appropriate power line outlet, this cable grounds the charger power supply 
case. Various power cables are available to connect the charger power supply 
to the types of AC power outlets unique to specific geographic areas.

WARNING Failure to ground the charger properly can result in personal injury. Insert the 
main power cable plug only into a socket outlet that has a protective earth 
contact. Do not defeat the earth-grounding protection by using an extension 
cable, power cable, or autotransformer without a protective ground conductor. 

If you are using an autotransformer, make sure its common terminal is 
connected to the protective earth contact of the power source outlet socket.
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What You’ll Find in This Chapter

To Do This See This

Troubleshoot resource problems “Resource Problems” on page 83.

Troubleshoot COM errors “COM Errors” on page 84. For more information 
refer to “Installing the Software” on page 51.

Update the software “Updating the Software” on page 89.

Update the firmware “Updating the Firmware” on page 90.

Get telephone assistance “Calling for Assistance” on page 92.

Return an Agilent Technologies receiver for 
service

“Returning the System for Service” on page 94.
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Troubleshooting Resource Problems and COM 
Errors

Resource Problems

CAUTION It is possible to exceed Windows 95/98 allocated resource levels by opening 
too many windows while running your Agilent E74xx system. This will cause 
erratic behavior of the application and require the operator to reboot the 
operating system in order to recover. This will also corrupt an open 
Agilent E74xx database, with potential loss of data. Windows 95/98 will not 
display any warning or feedback when this occurs.

The number of allowable open windows is dependent on the types you 
choose, as different windows require varying amounts of Windows 95/98 
resources. The maximum number of windows is approximately 12, although 
up to 14 can be opened in certain configurations.

To provide the maximum amount of available Windows 95/98 resources to 
the measurement application, it is strongly recommended that you close all 
other applications before running the Agilent E74xx software. This includes 
all applications found in the Startup folder. It is also recommended that you 
run the Windows 95/98 resource meter in a minimized configuration in order 
to monitor available remaining resources. 

To start the Windows 95/98 resource meter:

1. Choose Start > Programs > Accessories > System Tools > Resource 
Meter. The Resource Meter dialog box appears.

2. Click OK.

While this application utilizes system resources, it provides a way of 
determining when the system is running low on available resources. Opening 
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new windows with less than 20% remaining resources in any of the three 
categories could cause Windows 95/98 to overrun its resources.

One solution for increasing the potential number of measurements made in a 
given project without exceeding Windows 95/98 resources is to configure the 
measurement with the associated virtual front panel turned off. You will be 
able to record the data but not display it. This can be done in Configuration 
mode, under the Display/Logging tab found under the Measurement tab. 

The only solution for increasing the number of windows available during a 
measurement is to use Windows NT. It does not have the same systems 
resource limitations as Windows 95/98. 

COM Errors

The following procedure is suggested for locating and eliminating COM 
errors when using the Agilent Technologies RF wireless network test system.

NOTE To ensure that hardware is configured correctly, it is highly recommended that 
you use the automatic configuration wizard for setting up your projects. 
Refer to the online help for information.
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NOTE COM Errors may occur if the SAGEM phone is not set in the correct 
operating mode. The correct mode is TRACE.

When the SAGEM phone is in DATA mode, the interface connection is used 
for transmitting fax and other data transmission types. When the SAGEM 
phone is in TRACE mode, the interface connection is used for transmitting 
measurement reports.

To change the mode, switch on the phone and use the following phone 
keystrokes:

• [Menu], [44], Down Arrow, [#], [8]

• Use the up and down arrows to select TRACE mode, then select OK.

Table 5-1

Do This Additional Information

1 Check the project and configuration being 
used by the application.

• Does the hardware configuration for the 
project selected match the actual system 
hardware?

• Is the correct Agilent receiver model number 
and COM port selection shown in 
Configuration under the Hardware tab?

• Is the correct phone model number and COM 
port selection shown in the Configuration 
under the Hardware tab?

2 Check system hardware components. • Is DC power provided to the Agilent digital 
receiver?
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Do This Additional Information

2 (Continued) Check system hardware 
components.

• Is the phone turned on and does the battery 
show sufficient power (phone-based system)?

• Is the interface cable connected between the 
phone and the PC (phone-based system)?

• Is the second COM port defined and 
functioning (phone-based system)?

3 Troubleshoot COM errors. • Verify steps 1 and 2 are true.

• Check the Agilent E645x receiver by 
performing Verification Test 1, 2, or 3 and 
confirm no COM errors by going to Collection 
mode and viewing the Spectrum virtual front 
panel. Refer to Chapter 4 in the Agilent 
Technologies Wireless Solutions Getting 
Started Guide, available in PDF format in the 
\documents directory, for information on 
verification tests.

• Check the phone by defining a new project 
with only the correct phone model number 
and COM port selection, then going to 
Collection mode and viewing the Phone 
Measurements virtual front panel (phone-
based system).
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Do This Additional Information

3 (Continued) Troubleshoot COM errors. • Check the RS-232 interface cable between 
the PC and Receiver.

• If the RS-232 connection between the 
Receiver and PC is bad (broken or damaged 
cable or connectors) or communication is 
broken, then the error displayed will indicate 
that the Receiver may be in fault. Check the 
RS-232 cable or replace it. If the fault persists, 
contact Agilent Technologies.

• Check the connection between the USB serial 
converter and the PC.
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4 If all else fails. • Define a new project, checking on all items 
listed in steps 1 and 2.

• Use a different database by selecting File, 
Open Database, or creating a new database 
by selecting File, New Database, then 
defining a new project, checking on all items 
listed in steps 1 and 2.

• Repair the existing database by creating a 
new database, then using Tools, Database 
Utilities, Repair to open the original database 
(usually data.mdb). Once repaired, return 
to the original database by selecting File, 
Open Database with the original file name. 
Select the original project, checking on all 
items listed in steps 1 and 2.

• Use a brand new database. Using Windows 
Explorer, copy the file Design.mdb found 
in the working directory for the application 
(usually \Program Files 
\Agilent Technologies 
\E74xx), to a new file name then repeat 
step 4.

• When nothing else works, re-install the 
application. Copy the database in question to 
another location. Uninstall the current 
installation of the application by using the 
Add/Remove Program application, found in 
the Control Panel under Start, Settings. 
Once the application has been uninstalled, 
re-install the application.

Do This Additional Information
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Updating the Software

Software updates are available to download from the web. Your computer 
must be web-enabled to perform this process: you must have a modem or 
LAN access to the web, a service provider, and a web browser. If you are set 
up to access the web, go to the following web site and follow the links to your 
particular system:

http://agilent.com/find/networks

Once you have found your system, click on the Support link for information on 
software updates.

NOTE If you are unable to access the web, contact your Agilent Technologies 
representative for information about updating the software.
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Updating the Firmware

Sometimes a software update (see “Updating the Software” on page 89) also 
requires a firmware update. With the software update installed, when you
the updated software and select Collection mode, you will be notified if a 
firmware update is required. A series of messages will walk you through 
firmware update process. Before you update the firmware, you must first 
insert a firmware write enable key (E6450-60007) into the RX LOOP OUT
connector, as shown in Figure 5-1, then follow the instructions on the screen
Remember to remove and safely store the firmware write enable key whe
you are prompted to do so by the software.

Figure 5-1 Firmware Write Enable Key
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Replacement Firmware Security Key

If you have misplaced your firmware write enable key, you can order a new 
one (order from your Agilent Technologies representative, E6450-60007), or 
you can substitute a piece of wire that shorts pins 8 to 10 on the RX LOOP 
OUT connector (see Figure 5-2). Remember to follow on screen instructions, 
and remove the wire when you are prompted by the software.

Figure 5-2 Short These Pins to Update the Firmware

If you are set up to access the web, go to the following web site and follow the 
links to your particular system:

http://agilent.com/find/networks

Once you have found your system, click on the Support link for information on 
software updates.
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Calling for Assistance

Your indoor wireless solution is designed to provide dependable service. It is 
unlikely that you will experience a problem. However, Agilent Technologies 
sales and service organization is ready to provide the support you need.

If You Have a Problem

If you have a problem, refer to the following for possible help:

• This guide (also in PDF format on your CD)
• The E74xx Getting Started Guide (in PDF format on your CD)
• Online help
• Online tutorial

If you are unable to resolve your problem, refer to the information in the 
following section.

Frequenctly Asked Questions

If you need installation or application assistance, refer to the web site at:

http://www.tm.agilent.com/

To access the frequently asked questions section:

1. Click on the Technical Support link.

2. Type drive test in the dialog box under the title Enter a Search Word or Phrase: 
on the right of the screen.

3. In the Search Only For Document Type(s): list, select Frequently Asked Questions as 
your search item.

4. In the Specify Your Search Criteria Matches box, select exact phrase.
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5. Click the Search button.

If you do not have access to the web, contact your local Agilent Technologies 
representative for information.

Technical Telephone Assistance

Your network test solution comes with 12 months of technical telephone 
assistance and a 12 month hardware warranty period. To use the telephone 
assistance:

1. Install the software.

2. The Customer Business Center will provide you with a packet of 
information, which includes your system handle number. Please refer to 
that number when calling for support.

To establish a Support Contact, please call the Customer Business Center. 

3. Ask the Agilent Technologies engineer your question.

Numbers to Call

For a more detailed list of contact numbers, please refer to the above web site 
or contact your local Agilent Technologies Sales and Service Office.

Before calling, ensure you have all the information described above.

Table 5-2

Region Phone Number

Americas +1-800-698-0061, press 3

Asia, Australasia +65 271 0915

Europe, Africa, Middle East +31 20 547 9900
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Returning the System for Service

The instructions in this section show you how to properly package the system 
for return to Agilent Technologies. 

Warranty

If the system is still under warranty or is covered by an Agilent Technologies 
maintenance contract, it will be repaired under the terms of the warranty or 
contract (the warranty is at the front of this manual). If the system is no longer 
under warranty or is not covered by an Agilent Technologies maintenance 
plan, Agilent Technologies will notify you of the cost of the repair after 
examining the unit.

When a system is returned to Agilent Technologies for servicing, it must be 
adequately packaged (see “Preparing the System for Shipping” on page 95) 
and have a complete description of the failure symptoms attached. 

When describing the failure, please be as specific as possible about the n
of the problem. Include copies of additional failure information (such as 
receiver or computer failure settings, data related to system failure, and e
messages) along with the system being returned. 

Please notify Agilent Technologies before returning your system for servi
Any special arrangements for the system can be discussed at this time. T
will help Agilent Technologies repair and return your system as quickly as
possible. 
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Preparing the System for Shipping

Do This Additional Information

1 Write a complete description of the failure and 
attach it to the system.

Include any specific performance details related 
to the problem. The following information should 
be returned with the system:

• Type of service required

• Date system was returned for repair

• Description of the problem:

• Whether problem is constant or intermittent

• Whether system is temperature-sensitive

• Whether system is vibration sensitive

• System settings required to reproduce the 
problem

• Error Code

• Performance data

• Company Name and return address

• Name and phone number of technical contact 
person

• Model number of returned system

• Full serial number of returned system

• List of any accessories returned with the 
system

2 Cover all front and rear panel connectors that 
were originally covered when you first 
received the system.

3 Pack the system in the original shipping 
containers. Original materials are available 
through Agilent Technologies office. See step 
4 for more information.
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CAUTION • Cover electrical connectors to protect sensitive components from 
electrostatic damage.

• Instrument damage can result from using packaging materials other than 
the original materials. Never use styrene pellets as packaging material. 
They do not adequately cushion the system or prevent it from shifting in 
the carton. They may also cause system damage by generating static 
electricity. 

4 Wrap the system in antistatic plastic to reduce 
the possibility of damage caused by 
electrostatic discharge.

• For systems weighing less than 54 kg 
(120 lbs), use a double-walled, corrugated 
cardboard carton of 159 kg (350 lbs) test 
strength.

• The carton must be large enough to allow 3 to 
4 inches on all sides of the system for packing 
material, and strong enough to accommodate 
the weight of the system.

• Surround the equipment with 3 to 4 inches of 
packing material, to protect the system and 
prevent it from moving in the carton. If packing 
foam is not available, the best alternative is 
S.D-240 Air Cap from Sealed Air 
Corporation (Commerce, California 90001). 
Air Cap looks like a plastic sheet filled with air 
bubbles. Use the pink (antistatic) Air Cap to 
reduce static electrical damage. Wrapping the 
system several times in this material will 
protect the system and prevent it from moving 
in the carton.

5 Seal the carton with strong nylon adhesive 
tape and mark it “FRAGILE, HANDLE WITH 
CARE”.

6 Retain copies of all shipping papers.

Do This Additional Information
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Warning and Caution Notices

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the system. This product 
has been designed and tested in accordance with appropriate international 
standards.

WARNING The WARNING notice denotes a hazard. It calls attention to a procedure, 
practice, or the like, that, if not correctly performed or adhered to, could result in 
personal injury. Do not proceed beyond a WARNING notice until the indicated 
conditions are fully understood and met.

CAUTION The CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, which, if not correctly performed or adhered 
to, could result in damage to the product or loss of important data. Do not 
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Instrument Markings

When you see this symbol on your instrument, you should refer to the 
instrument’s instruction manual for important information.

This symbol indicates hazardous voltages.

The laser radiation symbol is marked on products that have a laser output.

This symbol indicates that the instrument requires alternating current (ac) input.

This symbol indicates that the instrument requires direct current (dc) input.

The CE mark is a registered trademark of the European Community. If it is 
accompanied by a year, it indicates the year the design was proven.

The CSA mark is a registered trademark of the Canadian Standards Association.

ISM 1-A This text indicates that the instrument is an Industrial Scientific and Medical 
Group 1 Class A product (CISPER 11, Clause 4).

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in STANDBY position.

The C-Tick mark is a registered trademark of the Spectrum Management Agency 
of Australia. This signifies compliance with the Australian EMC Framework 
Regulations under the terms of the Radio communications Act of 1992

This symbol indicates that the power line switch is in OFF position.

!

N279
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General Safety Considerations

The Agilent digital receiver has been designed and tested in accordance with 
IEC Publication 1010, Safety Requirements for Electronic Measuring 
Apparatus, and has been supplied in a safe condition. The documentation 
contains information and warnings which must be followed by the user to 
ensure safe operation and to maintain the product in a safe condition.

WARNING • If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

• No operator serviceable parts are inside this system. Refer servicing to a 
qualified Agilent Technologies, Inc. service center. To prevent electrical 
shock, do not remove the covers.

• To prevent electrical shock, disconnect the Agilent E74xx receiver from 
mains before cleaning. Use a dry cloth or one slightly dampened with water 
to clean the external case parts. Do not attempt to clean the receiver 
internally.
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Product Installation, Use, and Storage

CAUTION • This Agilent digital receiver is designed for use in INSTALLATION 
CATEGORY II and POLLUTION DEGREE 2, per IEC 1010 and 664 
respectively.

• Enclosure protection IP40 according to IEC 529. 

• Install the system according to the enclosure protection provided. This 
system does not protect against the ingress of water. This instrument 
protects against entry of solid foreign objects greater than, or equal to, 
one millimeter. 

Product Power

CAUTION • The input power to the Agilent digital receiver should not exceed 
–15 dBm. Power levels greater than +10 dBm will damage the 
instrument.

• For continued protection against fire hazard, replace the line fuse 
(cigarette lighter/2 amp 32 V FB fuse) only with the same type of rating 
(type nA/nV). The use of other fuses or materials is prohibited.

• If you use external power, install the instrument so the detachable power 
cord is readily identifiable and is easily reached by the operator. The 
detachable power cord is the instrument disconnecting device. It 
disconnects the mains circuit from the mains supply before other parts of 
the instrument. 

• If you do not use external power, position the product so you can easily 
operate the disconnecting device. 
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Declarations of Conformity

 Declaration of Conformity
according to ISO/IEC Guide 22 and EN45014

Manufacturer’s Name: Agilent Technologies, Inc.

Manufacturer's Address: 1400 Fountaingrove Parkway
Santa Rosa, CA 95403-1799
USA

Declares that the product

Product Name: Drive Test System

Model Numbers: Agilent E7473A, Agilent E7474A, Agilent E7476A, Agilent E7477A

Product Options: This declaration covers all options of the above products.

Conforms to the following product specifications:

EMC: CISPR 11:1990/EN 55011:1991 Group 1, Class A
IEC 801-2:1984/EN 50082-1:1992 4 kV CD, 8 kV AD
IEC 801-3:1984/EN 50082-1:1992 3 V/m, 27-500 MHz
IEC 801-4:1988/EN 50082-1:1992 0.5 kV sig. lines, 1 kV power lines

Safety: IEC 61010-1:1990  + A1:1992 + A2:1995 / EN 61010-1:1993 +A2:1995
CAN/CSA-C22.2 No. 1010.1-92

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC 
Directive 89/336/EEC, and carries the CE-marking accordingly.

Santa Rosa, CA, USA 25 April 2000

 Location Date Greg Pfeiffer
Quality Engineering Manager

For further information, please contact your local Agilent Technologies sales Office, agent, or distributor
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 Declaration of Conformity
according to ISO/IEC Guide 22 and EN45014

Manufacturer’s Name: Agilent Technologies, Inc.

Manufacturer's Address: 1400 Fountaingrove Parkway
Santa Rosa, CA 95403-1799
USA

Declares that the product

Product Name: Over Air Maintenance Tool

Model Numbers:  Agilent E7490A

Product Options: This declaration covers all options of the above products.

Conforms to the following product specifications:

EMC: CISPR 11:1990/EN 55011:1991 Group 1, Class A
IEC 801-2:1984/EN 50082-1:1992 4 kV CD, 8 kV AD
IEC 801-3:1984/EN 50082-1:1992 3 V/m, 27-500 MHz
IEC 801-4:1988/EN 50082-1:1992 0.5 kV sig. lines, 1 kV power lines

Safety: IEC 61010-1:1990  + A1:1992 + A2:1995 / EN 61010-1:1993 +A2:1995
CAN/CSA-C22.2 No. 1010.1-92

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC 
Directive 89/336/EEC, and carries the CE-marking accordingly.

Santa Rosa, CA, USA 25 April 2000

 Location Date Greg Pfeiffer
Quality Engineering Manager

For further information, please contact your local Agilent Technologies sales Office, agent, or distributor
Agilent Wireless Solutions 103



Safety and Regulatory Information
Declarations of Conformity

indoor_gsg.book  Page 104  Tuesday, September 26, 2000  10:08 AM
 Declaration of Conformity
according to ISO/IEC Guide 22 and CEN/CENELEC EN45014

Manufacturer’s Name: Agilent Technologies

Manufacturer's Address: South Queensferry
West Lothian, EH30 9TG
Scotland, United Kingdom

Declares that the product

Product Name: GSM Drive Test System

Model Numbers: Agilent E7475A

Product Options: This declaration covers all options of the above product as detailed in 
TCF A-5951-9852-09.

Conforms with the protection requirements of European Council Directive 89/336/EEC on the approximation 
of the laws of the member states relating to electromagnetic compatibility, against EMC test specifications EN 
55011:1991 (Group 1, Class A) and EN 50082-1:1992 .

As Detailed in: Electromagnetic Compatibility (EMC)
Technical Construction File (TCF) No. A-5951-9852-02

Assessed by: DTI Appointed Competent Body
EMC Test Centre, GEC-Marconi Avionics Ltd.,
Maxwell Building, Donibristle Industrial Park,
Hillend, Dunfermline, KY11 9LB
Scotland, United Kingdom

Technical Report Number:6893/2201/CBR, dated 23 September 1997

Safety:

The product conforms to the following safety standards:

IEC 61010-1(1990) +A1(1992) +A2(1995) / EN 61010-1:1993
IEC 60825-1(1993) / EN 60825-1:1994
Canada / CSA-C22.2 No. 1010.1-93

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC, and carries 
the CE mark accordingly.

South Queensferry, Scotland 28 April 2000

 Location Date R. M. Evans
Quality Manager

For further information, please contact your local Agilent Technologies sales Office, agent, or distributor
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